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About Technical Software Systems

Technical  Software  Systems,  located  in  northern  New Jersey,  is  committed  to  providing 
quality low-cost microcomputer software tools for engineers and scientists. We specialize in 
scientific  programming  for  the  MS-DOS  and  Macintosh  environments.  Our  background 
includes extensive experience in numerical analysis and simulation, civil  engineering and 
systems-level programming. Please contact the address on the cover page for information 
regarding  new  technical  software  products  or  custom  application  development  in  these 
fields.

Warranty Information

If physical defects are discovered in the media or manuals comprising this software product, 
Technical Software Systems (TSS) will replace them at no charge, provided you return the 
item to be replaced along with proof of shareware purchase during the 90 day period after 
the  purchase.  All  sales  are  final.  Please  see  the  accompanying  shareware  registration 
document for more information.

TSS makes no warranty, either express or implied, with respect to this software or its quality, 
performance, merchantability, or applicability to a particular purpose. Therefore, this package 
is sold "as is". TSS will not, in any event, be liable for damages of any kind resulting from a 
defect in the software or its documentation.
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Contour81 V 1.1 Introduction
---------------------------------------------------------------------------------------------

What is Contour81 and who would use it?

Contour81 is  an application that  creates contour maps and pictures from lists of  three-
dimensional data. A contour map is a two-dimensional picture of a surface defined by a set 
of  data points.  The points would usually be elevations of  a physical  location,  such as a 
planned construction site. A survey crew would go to the site and essentially return with 
(among other things) a list of "points". Each one of these points would specify the elevation 
of some location at the site. Then, an engineer or draftsperson would have to plot the points  
and draw contour lines according to general rules of thumb. These contour lines would then 
represent locations at which the elevation was constant. A person could walk along the line 
and not move up or down with respect to a reference elevation at all. The site engineer can 
look at this contour map and calculate the volumes of various areas defined by the contour 
lines. In the case of site development, this tells him or her how much earth must be moved 
from  one  place  to  another  in  order  to  change  the  topography  of  the  location  into  an 
acceptable form. A hydrologic engineer could look at the map and tell where flood areas 
would occur and the way that water would move around the site in a rainstorm. For example,  
water  always  seeks  the  lowest  level  as  quickly  as  possible.  Therefore  it  would  flow 
perpendicular to the contour lines (the gradient), because that is the quickest way for it to 
change its elevation. Another type of contour map might be a scientist's plot of the electric 
potential (voltage) in an area of space. Then the contour lines would define equipotentials, 
a  loose  definition  of  these  being  lines  that  a  charged  particle  could  move  on  without 
changing its energy. In this example, if we draw lines perpendicular  to the contour lines, 
these represent the electric field.

In case you haven't guessed already, the process of drawing these contour maps by hand 
can be extremely tedious and time-consuming. Until the relatively recent advent of low-cost 
microcomputers, however, this was (and still  is) the only way available to some technical 
people. This program provides the necessary mathematical and graphic power in an simple, 
low-cost application that adheres to the Macintosh™ User Interface Guidelines. We must 
assume that you are familiar with basic Macintosh operation and are knowledgeable about 
the meaning of your three-dimensional data and its analysis. You do not have to understand 
any of the mathematics behind the program if you do not wish to, but a full explanation of the 
process is provided for those who are interested. Please also note that the generation of 
hard copy from this program also requires the use of MacDraw™, AutoCAD™ or another 
program that can read and work with PICT or DXF™ files.
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Contour81 V1.1 Program Specification
---------------------------------------------------------------------------------------------

The Contour81 program offers the following capabilities and features:

- It can handle up to 1,000 input points, and it can generate a contour plot
of up to 20,000 vectors. Input comes from standard TEXT files.

- The dimensions of the contoured grid can be as great as 100 x 100, and
up to 50 contour elevations can be plotted.

- The user has full control over the X and Y coordinates and limits, the
Z values for contouring, and the appearance of the finished plot.

- A weighted least-squares approximation method is used along with
inline MC68881 math coprocessor instructions for maximum speed
and accuracy.

- It can generate regular contour plots ("plan view") or it can rotate the
viewing angle and show a three-dimensional representation of the
surface. If the appropriate color hardware is available the plots can
be viewed and printed in color.

- Plots and plot information can be saved in PICT, DXF or TEXT format,
and can then be transferred to the appropriate program for editing
prior to printing or inclusion in a report. The TEXT format allows user
programs to access the generated data.

- With the use of MacDraw or another graphics program that can import
PICT files and drive a plotter, you can generate plots on standard technical
sheets of large sizes (i.e. 24" x 36", 36" x 48").
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The operation of Contour81 is simple and can even be done by persons who have only a 
basic familiarity with the Macintosh. The paragraphs that follow demonstrate this process.

Step A - Getting the Data In

Before the program can be run, an "input file" must be prepared. This file must be of the 
following general form:

14.276 56.47 213.3
17.83 47.892 243.01
.
.
.
45.34 32.01 272.45
56.346 12.62 249.4
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---------------------------------------------------------------------------------------------

This input file has the following characteristics:

- It has 3 numerical values per line, representing the X, Y and Z coordinates
of a point.

- The X, Y and Z values are separated by spaces only.

- Blank lines and lines that start with an asterisk (for comments) are ignored.
Lines of any other form will keep the input file from being accepted
by the program.

It may be created by MDS Edit™, MacWrite™ (saved under "Save As…"  with the "Text 
Only" option selected), or any other application that can create files of type TEXT. If MS-
Excel™ is used to save to a text file, it puts tabs in on the blank lines. Contour81 can not 
accept this, so put an asterisk in column 1 of any blank line before saving it to a TEXT file.

Step B - Setting Grid Parameters

Now that a valid input file exists, the Contour81 program can be executed. Double-click on 
the program icon. (If you have a hard disk you may drag the Contour81 application icon to a 
folder on your hard disk and use it there.) After clicking on "OK" to remove the title screen, 
choose "Open input…" from the File Menu or type Option-O. Then choose the input file that 
you just created from this list. Now the program will read in your input file (this may take a 
few seconds) and the contouring process can begin.

Step C - Create the Contour Plot

After the input file is loaded in (the watch icon disappears), choose "Go" or type Option-G. 
The dialog box at the top of page 7 appears on your screen:
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Contour81 V1.1 Program Operation
---------------------------------------------------------------------------------------------

This is where you can set all  the parameters that deal with the location and size of the 
contour map. Hitting the Automatic button will change the "low" and "high" values into values 
that come from the input file, i.e. the physical boundaries of that data. Of course, any of 
these items may be overridden by changing the appropriate number.

For X and Y, the number in the "low" column is the lowest coordinate that the contour map 
will be drawn over and the number in the "high" column is the highest coordinate. Using 
these numbers you can get a general plot of your area, then zoom in on spots of particular 
detail. The "#" field for X and Y is the number of grid squares, so a 10 x 10 grid would have 
100 squares. Note that the time that Contour81 takes to generate your contour plot will be 
proportional  to  the  product of  these  2  numbers.  For  more  information  on  this  see  the 
Mathematics section of this manual.
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Contour81 V1.1 Program Operation
---------------------------------------------------------------------------------------------

The Z fields deal with the contour values. These are the values for which contour lines will 
be drawn. As with X and Y, the "low" and "high" fields signify the lower and upper bounds of 
this range. The "inc" field is slightly different here in that it represents the increment use to go 
from the "low" and "high" Z values. For example, if we set the Z "low" to 5.0, the Z "high" to  
9.0 and the Z "inc" to 1.0, then we will get contour lines on our plot that represent Z values of 
5.0, 6.0, 7.0, 8.0 and 9.0 and are labeled correspondingly. The Z "inc" value has no meaning 
when you generate a three-dimensional surface.

When you are satisfied with all  of  these settings,  click OK or hit  RETURN to begin the 
contouring process. If you change your mind, just click on the Cancel button and all of your 
changes will be discarded and all settings will revert back to their original values.

Once OK is  chosen,  a window like the one above appears and the contouring process 
begins. If you wish to learn more about this mathematical process, we encourage you to turn 
to the Mathematics section and read more about it.  The thermometer-like status window 
shows the  "percent  complete"  of  the  process.  For  a  large  input  file  and many gridding 
intervals this process can be quite lengthy, even on a Mac II. Contour81 tries to achieve an 
optimum balance between simplicity of operation, speed and accuracy.

At the time of this writing,  Contour81 works under MultiFinder™, specifically the release 
included with System 6.0.  During the gridding process it  is  usually possible to switch to 
another application and continue working. However, we have not tested it extensively with all 
other programs and we can not recommend its use in this manner for this reason.

If you wish to interrupt the process for any reason, hit Option-Period. The contouring process 
will be terminated.
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Step D - View the Plot

When the mathematical  machinations are complete,  Contour81 will  beep and display a 
dialog box informing you of  this.  If  the internal  vector  storage limits  of  the program are 
exceeded, another dialog box will inform you of this fact also. If this occurs, the program will 
generate as much of the plot as it can. Reduce the size of your grid or the number of contour 
levels.

After a time period for generating the picture, your contour map or three-dimensional plot will 
now be displayed on the screen. Shown below are samples of program output:

This is a sample of the plot that results when you do not check the "Draw as terrain map" 
box under "Graph Options…". The contour lines are labeled with their elevations, and the 
grid and grid markings are placed over the plot. Since the plot will probably be
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Contour81 V1.1 Program Operation
---------------------------------------------------------------------------------------------

bigger than the screen, you can use the scroll bars and window sizing controls in the usual 
manner to view different parts of the plot. On the Mac II the contour lines and labels are in 
color with blue being the color of highest Z value and red being the lowest. Note that 256 
color capability is not required to run Contour81, and in fact we recommend that you place 
your monitor in 16-color mode for speedier graphics.

This is a sample of the plot that results when you check the "Draw as terrain map" box under 
"Graph Options…". On a Mac II, the color scheme is the same as on the previous plot. Here 
the computer has in effect interpolated a three-dimensional surface through all of your data 
points. The appearance of both the three-dimensional and "plan view" contour pictures can 
be modified by the user by accessing the "Graph Options…" choice under the Options Menu. 
Refer to the Special Options section for more information.
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Step E - Saving the Plot

Contour81 interfaces to other programs through its capability to save contour and surface 
pictures into files. While you can certainly use the "Copy" feature from the Edit Menu to copy 
and paste a plot into another program (if the window is active), you should also save it in a 
file  so  that  later  you  can  bring  the  picture  into  one  of  the  many  graphics  applications 
available. In the graphics program you can add notes, change the size of the picture, etc. 
prior to including the picture in a report or spreadsheet.

After you have finished viewing the contour plot,  choose "Close" from the File Menu (or 
Option-W) or click on the window close box. The following dialog will be presented:

Choose the format of your choice and click the Save box or hit RETURN. The standard file 
dialog will  prompt you for a file name and your plot will  be saved under that name. The 
window will close and you may now generate a different type of plot, change some plotting 
parameters, load a different input file, or leave the program.

If any of the X and Y options on the "XYZ Value Selection" dialog (page 7) or any of the 
options on the "Weighting Function" dialog (page 14) are changed, the program will have to 
regrid the data. 
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Contour81 V1.1 Output Files
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Output Files

As stated in the Program Specifications section, Contour81 allows you to save your plot in 
PICT format (a common format usable between all graphics programs), DXF format, which is 
the standard interchange format between CAD programs such as AutoCAD, or TEXT format. 
The TEXT format just creates a text file of vectors (if you drew a plan view plot) or elevations 
at grid points (if you chose a three-dimensional surface). Examples of these 2 TEXT output 
formats are below.

If you have chosen to generate a plan view contour plot, this is a listing of a sample output 
file  produced  by  the  "X1-Y1-X2-Y2-Z"  option  on  the  "Save  contour  picture  as:"  dialog. 
Starting with the third line and listed in order from left to right are the X and Y coordinates of  
the beginning point of a contour line, the X and Y coordinates of its end point, and its Z 
value:

* TEXT file created by Contour81 V1.1
* input file: bob s-test3   date: 10/ 8/1988   time: 15:32:22
  35.668    79.993    35.483    79.643   120.360
  36.006    80.703    35.668    79.993   120.360
  34.622    81.077    33.862    79.643   121.360
  34.622    81.077    35.541    83.008   121.360
  35.779    83.490    35.541    83.008   121.360
  .
  .
  39.321    80.056    39.106    79.643   118.360
  39.719    80.922    39.321    80.056   118.360
  38.121    81.299    37.257    79.643   119.360
  38.121    81.299    38.589    82.319   119.360

If you have chosen to generate a three-dimensional surface picture, the following is a listing 
of  the  output  produced  by  the  "X-Y-Z"  option  on  the  "Save  contour  picture  as:"  dialog. 
Starting with the third line and listed in order from left to right (on the next page) are the X, Y  
and Z coordinates of each grid point.
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* TEXT file created by Contour81 V1.1
* input file: bob s-test3   date: 10/ 8/1988   time: 15:33: 7
  28.580    45.020   120.717
  28.580    48.867   120.294
  28.580    52.714   120.081
  28.580    56.561   120.111
  28.580    60.408   120.381
  28.580    64.255   120.864
  28.580    68.102   121.551
  .
  .
  32.293    45.020   119.871
  32.293    48.867   119.413
  32.293    52.714   119.006
  32.293    56.561   118.747
  32.293    60.408   118.789

These files are of type TEXT and can be viewed with MDS Edit or MacWrite. The capability 
to  create  these  files  was  provided  so  that  Contour81 can  interface  with  user-written 
programs for other types of data analysis.

The PICT file option is the output format option that will probably be used most often. Once a 
picture has been saved as a PICT file, almost any graphics application can be used to load it  
and make modifications. However, most of these "object-type" graphics programs do not 
support colored "regions", which means that the colors that are given to surface patches in a 
three-dimensional plot will be ignored. Try loading the PICT file into a "paint-type" program 
that supports color, such as PixelPaint™.

The DXF format option is included for the benefit of those who have access to the CAD 
power of AutoCAD or other programs that can access DXF files (on the Macintosh or MS-
DOS™ machines). The contour plots are stored in color 7 on layer "0". The plan view plot is 
comprised of 3DLINEs and the three-dimensional surface plot is stored as 3DFACEs.
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Contour81 V1.1 Special Options
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Next to the Edit Menu on the menu bar can be found the Options Menu. Under the Options 
Menu are three menu choices. The first choice is "XYZ values…" and choosing it results in a 
dialog similar to the one on page 7.  The second choice from the top is "Weighting…" and it 
offers the following dialog:

The  options  in  this  dialog  probably  won't  have  to  be  changed very  often,  but  they  are 
provided for extra flexibility. The three functions along the top are the weighting functions that 
the  program uses  when gridding  points.  Simply  put,  the  weighting  function  controls  the 
amount of influence that other points have on the interpolated value at a given point. It is 
always a function of the distance (d) between the other points and the grid point in question. 
µ and ∂ are constants used to avoid any points of discontinuity. They should always be on 
the order of the inverse of the square of the average distances between nearby data points. 
The search radius is the maximum distance around a grid point to search for points to use in 
that grid point's interpolation. By experimenting with the weighting functions you will be able 
to see the different effects they have on a contour map of a given set of points.
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The last choice on the "Options" Menu is "Graph Options…" In this dialog are the controls for 
the graphic output of the program, including the type and size of a graph and options for that 
type of graph. 

On the left side of the dialog are the check boxes for the different types of pictures and 
additions. We purposely added these options because even though a user could certainly 
bring the PICT file into MacDraw or some other program and make all sorts of modifications, 
that would still  take some time which could be saved by adding or removing the objects 
beforehand. The first box is "Elevation labels". This controls whether or not the elevations of 
the contour lines will be printed on the contour lines themselves. Remove the check if you do 
not want these labels. The second box, "X and Y axis labels/ticks", controls whether or not 
the axes will be labeled and small tick marks drawn at these labeling points. Remove the 
check if you do not want these additions. Third is "Draw grid lines on picture". This controls 
whether or not the grid lines will be printed. The grid lines go from side to side of the plot and 
coincide with the tick marks, axis labels and grid points. Remove the check if you do not 
want these grid lines. 
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The fourth option is used to indicate whether a three-dimensional "terrain map"-type surface 
plot should be drawn or if a "plan view" contour plot is desired. Note that the first  three 
options  have  no  effect  on  a  "terrain  map"  plot  because  no  exact  contours  are  really 
distinguishable.

If  color  hardware  is  available,  the  fifth  check  box,  "Color  different  elevations"  can  be 
selected. If it is selected then all plots will take advantage of color on the screen to represent 
different elevations. PICT files will also be saved with color information inside. On a machine 
that does not support color it will be impossible to select this option. The sixth option on the 
left controls whether the points in the input file will be plotted as small dots inside circles. 
Check the box if you are generating a plan view contour plot and you want this addition.

The "pixels/unit  dist"  entry  controls  the size of  a  plan view contour  plot.  The larger  the 
number, the larger the picture. It also has no effect on a three-dimensional plot. It is set at 
startup to give a plot that fills the screen. The "view angle" option simply controls the angle of 
viewing for a three-dimensional plot. An entry of 0.0 will give a viewpoint directly overhead, 
while an angle of 90.0 will  generate the picture as if  you were standing at 0.0 elevation 
looking in the positive Y direction. An angle of 70 usually gives a good-looking plot.

The last option, "Z corr" is a Z correction to subtract from the base elevation of a three-
dimensional plot.  Normally it  will  be automatically set to the minimum contour level,  and 
rarely needs to be changed. Increasing it will move the surface downward and vice versa. 
The user is encouraged to experiment with all of the above graphic options and determine 
the type of plot he or she wants to generate, keeping in mind that the full editing power of 
commercial graphics applications is always available.
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The algorithm behind Contour81 involves a certain amount of higher mathematics, but it is 
not beyond the reach of anyone with a technical education. The basic process is as follows: 
First, setup a rectangular grid according to the user input of the number of grid points in each 
direction and the values of xmin, xmax,  ymin  and ymax. Then calculate the z values of each grid 
point through interpolation of the input data points. Once this has been done we can treat  
each grid square as a four-sided figure in three-dimensional space. Since we also have a list 
of the contour values, we can easily draw any contour lines for this figure because they will 
be (if they exist) just the intersections of the figure and the planes parallel to the x-y plane at 
the contour value heights.

The idea behind the interpolation is to use the relative distances and directions of the data 
points to evaluate the coefficients of a quadratic polynomial to act as an approximation to the 
surface in that region. This second-order polynomial has the general form:

F (x, y)  =  a00 + a10 x + a01 y + a20 x y + a11 x 2 + a02 y 2

An additional requirement of ours will be that the data points that are closer to the grid point 
in question should "carry more weight" than points farther away. More explicitly, we wish to 
minimize the value of S in the following equation:

                                        n

                               S = Σ ( F (xi ,  yi)  -  zi  ) 2  w ( ( xi  -  a ) 2  +   ( xi  -  a ) 2)
                                      i = 1

with w(x) being a weighting function that gives us the desired effect, such as w(x) = exp(-d2) / 
d2. Other functions are on the Weighting Functions dialog. To do this we must use the above 
equation to solve six equations for the six unknowns amn. Contour81 does this through the 
use of Gaussian elimination with scaled partial pivoting. 

At this point we have a "mesh" of our interpolated grid points. This is all that is necessary to 
draw a three-dimensional "terrain map" plot. To draw a contour map we now need only to 
calculate the occurrences of our contour levels as lines that traverse these grid squares. 
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Contour81 V1.1 is © Copyright 1989 Technical 
Software Systems

P.O. Box 56
 Millburn, NJ 07041-1008

This manual and the software described in it are copyrighted with all rights reserved but are 
also "shareware" products. Please see the accompanying shareware registration document 
for more information.

Macintosh is a registered trademark and MultiFinder is a trademark of Apple Computer, Inc. 
MacDraw and MacWrite are registered trademarks of Claris Corporation.

MS-DOS and Excel are registered trademarks of Microsoft Corporation. AutoCAD is a 
registered trademark and DXF is a trademark of Autodesk, Inc.

MDS Edit is © Copyright 1987 Consulair Corporation. PixelPaint is a trademark of Pixel 
Resources, Inc.

This manual was written on an Macintosh II computer with MacWrite II software.

Technical Support

Technical Software Systems apologizes for the fact that at this time it is unable to offer 
telephone support for this product. The absence of this type of support is reflected in the 
shareware nature of the software. However you can reach us for any questions by writing to 
the above address or by contacting the following electronic mail addresses:

Internet: rxk9228%njitx.decnet@njitc.njit.edu
GEnie: R.KOZLOWSKI1

Thank you for using and purchasing this software.
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